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PREFACE
1 Preface

1.1 Quality Assurance
We thank you for choosing iQ.Suite. Before being released, all of our products 

pass through rigorous tests. No product is issued without having been subjected 

to an extensive test performed by our QA Team. 

1.2 Copyright
GROUP Technologies AG, hereafter referred to as GROUP, is the owner of the 

full commercial copyright of this documentation protected by law. All rights not 

explicitly granted remain the property of GROUP.

Copyright 1992-2002 GROUP Technologies AG. All rights reserved.

1.3 Warranty
GROUP is unable to guarantee, either explicitly or tacitly, the quality, execution, 

standardization or suitability for a specific purpose.

The product descriptions are general and descriptive in nature. They can be inter-

preted neither as a promise of specific properties nor as a declaration of guaran-

tee or warranty. The specifications and design of our products can be changed at 

any times without prior notice, especially to keep pace with technical develop-

ments. For information updates, please contact our Sales Department.

1.4 License Agreement
Please read our license agreement supplied with the product CD.

1.5 Third-Party Copyright Notes
IBM, AIX, OS/390, OS/400 and OS/2 are trademarks of the International Busi-

ness Corporation.

Lotus, Lotus Notes and Lotus Domino are registered trademarks of the Lotus 

Development Corporation.

Microsoft, MS, MS-DOS, Windows, Windows NT and Windows 2000 are regis-

tered trademarks of the Microsoft Corporation.

Solaris is the registered trademark of Sun Microsystems, Inc.
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INTRODUCTION
2 Introduction

2.1 The Aim of this Guide
As you will naturally want to make optimum and skilful use of your new applica-

tion software, we wish to give you the help you need. We have therefore tried to 

make this guide as easy to use and as understandable as possible. We would be 

grateful for any suggestions you have on how we can make further improve-

ments. Please send an e-mail to:

manual@group-technologies.com

2.2 Structure of this Guide
This guide uses the following conventions:

The following symbols are used:

Bold Menu names and entries, window names, entry and list 

boxes, messages, file names and important information are 

shown in bold type. 

Italics Entries that the Administrator must make are written in ita-

lics.

Fixed width Program code,  paths and folder names are written in 

fixed width font.

Links Underlined text is a hyperlink. It is usually blue.

The eye means "Attention!" Be careful! It indicates important pas-

sages in the text that must be observed in order to avoid any loss of 

data, damage to your system or any other unpleasant occurrences. 

Read these passages with particular care and attention. 

The info symbol is used to indicate special points that must be 

observed for trouble-free use of your system.
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Please refer to the “Glossary” on page 265.

2.3 organiziQ
Intelligence for e-mail organization

The complete organizational packet saves you valuable time and increases pro-

ductivity every day:

Time-optimized sending of e-mail

Advanced forwarding and delegation control

Ability to prioritize delivery of e-mails

Ability to delegate administration

2.3.1 organiziQ.Clerk
organiziQ.Clerk forwards your electronic mail arriving within specified periods to 

freely selectable persons or groups. e-mails from various senders or Internet 

domains can be forwarded or redirected to different deputies or representatives. 

Forwarding can be disabled where confidential information is involved. If 

A little gift to help you! Here, we give you support on particular prob-

lems, we provide tips and tricks or alternative solutions and special 

points.
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required, notifications and confirmations of receipt are sent to senders, recipients 

and deputies. organiziQ.Clerk can be activated on a central basis.

Easily configurable, central e-mail forwarding by authorized users and 

administrators

Freely definable deputies and deputy groups

Freely definable forwarding periods

Specific disabling of forwarding for confidential or encrypted e-mails and for 

specified senders

Confirmations of receipt by deputies sent to absentees

Central overview of all absentees for authorized users

Internal and external e-mail forwarding restricted to authorized persons

Freely editable notification messages with %variables% for senders and 

deputies

Automatic identification of new e-mail boxes

2.3.2 organiziQ.Flash
e-mails appear at irregular intervals, which makes it difficult to choose the opti-

mum interval for Notes Client to check for new mails. If too short an interval is 

selected, the network is burdened unnecessarily; if the interval is too long, the 

user may receive an important message too late. organiziQ.Flash notifies the 

user in a matter of seconds that a new e-mail has arrived at the server. The mails 

are listed at the workstation with sender, subject and message text without being 

tied to a Notes Client. Various actions can be performed when an e-mail arrives at 

the client. organiziQ.Flash consists of two parts: The server part, which is 

installed on the Notes server, and the client part, which runs on the workstation 

PC.

Notification about incoming messages

Immediate, simultaneous support of multiple e-mail databases, including 

mail-in databases

Alternative notification in case of absence

Playing of any WAV files

Support for system speakers

Selectable prioritisation
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2.3.3 organiziQ.Smart
organiziQ.Smart efficiently contributes to load management within Domino infra-

structures. It also allows e-mail users to carry out their correspondence under tim-

ing/scheduling aspects. Furthermore, the resolution of DocLinks allows to 

transmit Notes text documents also to users of other e-mail systems.

Reliable options to reduce server and traffic load caused by large-sized e-

mails and attachments

Flexible options for end users to manage scheduled e-mail transmissions

Notification of sender regarding time-shifted e-mail transmission

Automatic e-mail messages to the administrator in case of errors

Safe archival of e-mails which could not be sent

Basis for further application possibilities such as "four eyes" principle
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3 organiziQ.Clerk - General

3.1 Basics
organiziQ.Clerk is the module for 

Absence management (Forward), and the

Electronic clerk (Redirect)

Clerk consists of two components: One component is the administration module, 

controlled on the server by the Notes administrator. In the second component, the 

separate Clerk database (g_del.nsf), each user can individually configure his or 

her delegation and forwarding options (depending on his or her authorization).

Represented graphically, organiziQ.Clerk works as follows:

This chapter explains in detail how to set up forwarding and redirection options. 

3.2 Starting organiziQ.Clerk
Start your Notes client and open the Clerk database (g_del.nsf). To do so, pro-

ceed as follows:

Click on File  Database  Open and select the server on which the current 

organiziQ.Clerk database is to be found.
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For the name of the server (and, if required, the appropriate directory on the 

server), please contact your administrator. Now select the organiziQ.Clerk 7.5 or 

7.6 database and click on Open.

Select server 
here!
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3.3 The organiziQ.Clerk Database User Interface
When initially opening the database, the following screen will be displayed:

After opening the database, click on Language to select your preferred language. 

The key screen components are then displayed in the selected language.

Further information on all tabs and fields is provided in the context-sensitive 

online help. To display help text on the menu currently selected, click on Help.

Also, a printing options window is displayed when you click on Print.

On the left side, there is a menu subdivided into Personal Settings and New 

Entry. The options available will vary according to the authorization of the current 

user. Those belonging to the group of experienced organiziQ.Clerk users 

(GROUP-TOOLS-POWUSER) will see both Advanced Forward and Redirect. 

Standard users can only use Standard Forward.

Under Personal Settings - By User and Personal Settings - By Date, you will 

receive, as an standard user, a list of documents pertaining to you, i.e., docu-

ments for which you were designated as author/forwarder or deputy. You may 

view these documents by double-clicking. However, only the author (creator) is 

permitted to modify them. Experienced Clerk users may view all forwarding/redi-

rect documents.
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Typically, this list will look like the following:

Under New, you can create a new control document with Standard Forward, 

Advanced Forward or Redirect settings.

For information on authorization and membership in the group of experienced 

Clerk users, please contact your administrator.

3.4 Closing organiziQ.Clerk
To close the database, use ESC or the File menu. 

For further information on how to use the Lotus Notes Client, please refer to your 

Lotus Notes documentation.
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4 organiziQ.Clerk - Absence Management

4.1 Overview
The absence management system is designed to handle holiday and sickness 

leaves or business trips. You may name a deputy D for the period from S to E. D 

will receive a copy of every e-mail sent to you within the period you have defined. 

This copy will be provided with an automatic notification that you are absent and 

that D should deal with the matter concerned. At the same time, the sender X of 

the e-mail will automatically receive a notification that you are currently not avail-

able at your company. 

The following can be configured as required:

All notifications and messages 

Deputy D

Start time S

End time E

The control documents can be viewed and edited by others (e.g. by the secre-

tary), provided they are authorized to do so (refer to the authorization section on 

page 9). This option will be useful in the event of sickness when an employee 

cannot come to work in order to activate the absence management system, or 

when employees are frequently out of office.

Each user can create and configure his or her standard-forwarding documents in 

the organiziQ.Clerk database while authorized users may also create and config-

ure advanced-forwarding and redirect documents. For a more detailed descrip-

tion, please refer to “Organizing Deputies for Holiday and Sickness Leave” on 

page 12 and “Setting Up the Electronic Clerk” on page 19.

The two types of forwarding are:

A standard forwarding document:

is for an individual user (the author!),

goes to one or several deputies simultaneously (a notice of absence 

without forwarding is possible),

sets the period in days,

sets the texts (messages),
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enables to manually specify further persons as authors (separated by 

comma!).

An advanced forwarding document: 

has all the functions of the standard document,

additionally enables to define forwarding/deputy exceptions for specific 

senders,

allows to select document authors from the Notes address book,

allows to set forwarding options for other persons.

4.2 Organizing Deputies for Holiday and Sickness Leave
If you want to organize a deputy to handle a holiday or sickness leave, you must 

configure and activate the Personal Settings. You then have the choice between 

standard and advanced forwarding.

4.2.1 Advanced Forward
Only members of the experienced organiziQ.Clerk users group are allowed to set 

Advanced Forward options (also refer to the authorization section on page 9). 

The organiziQ.Clerk database version originally supplied contains two sample 

entries for Personal Settings. As almost all employees will have access to the 

Clerk database, these examples may well have been changed and therefore no 

longer be available.

In this case, please select New Entry --> Advanced Forward and create a new 

document, using the example described below as reference. Once you have cre-

ated the document, you can update your own entry any time by selecting it from 

the list (double-click).

Further information on individual fields and their options is provided in the Online 

Help, available under the Help menu.

1. Select: Personal Settings --> By Person

From the list displayed next, select (double-click) Kai London and change 

the document (--> Edit). 
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2. In the Basics tab, set the Personal Settings Status to Active.

Bob Washington is designated as deputy for the users Kai London and 

Mark Paris for the period from 18.07.2001 to 28.07.2001 included. Senders 

will be notified that their e-mails have been forwarded. Use these fields to 

change the user names for which forwarding is to be set up and to specify 

the deputy for this period. 

If you enter an asterisk (*) in the Forwarding recipient field, e-mails will 

not be systematically forwarded. In this case, forwarding is limited to the 

exceptions specified under Conditioned forward in the Advanced tab. 

The number sign (#) has the same effect, except that the sender of the e-

mail additionally receives the notification specified under the Message for 

sender in case of non-forwarding field in the Operations tab. You can 

thus use organiziQ.Clerk as an auto-reply system without having to acti-

vate forwarding.

For a forwarding, you may select one or several names from the Notes 

address book. Simply Add or Remove names from the selection displayed 

when you click on the arrow:

Click on the arrow 
to select a name
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3. Now select the Operations tab.

This tab is used to define the notification texts for the recipients and send-

ers of forwarded e-mails. These messages are attached to the original 

mail. Modify the settings according to your requirements, change the mes-

sage wording or simply use the default settings and just enter a date for the 

%FINAL-DATE% placeholder.

If you do not want the original message text to be available to your 

deputy, set the Replace original body to Yes. Your deputy then 

receives your messages only with the subject and your own message 

text. Keep in mind, however, that this makes it impossible for your 

deputy to reply to the message.

Select Address 
Book Add name

Select name

Remove name
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In the Advanced tab, enter the exceptions you wish to make.

Use the Person, Group, and Domain fields to define exceptions to the 

rule and forward any e-mails from these senders to other persons. 

In this example, the following exceptions have been defined:

a) E-mails coming from Leo Miller are not forwarded but sent to you per-

sonally (* entered).

b) E-mails from the Customers group are not forwarded, the sender only 

receives the absence notification as set in the Message for sender in 

case of non-forwarding field in the Operations tab (# entered).

c) E-mails from the Suppliers group are forwarded to Markus Bayer from 

Purchasing and not to the general deputy specified in the Basics tab.

You can use a * (asterisk) or a # (hash) character to suppress for-

warding e-mails from specified persons, groups or domains. 

The messages of senders marked with an asterisk (*) will be sent to 

you irrespective of your absence. You can use this, for example, if 

you are expecting a confidential message from a particular sender 

and do not want this message to be received by someone else. The 

# means that the sender receives an absence notification, the * that 

the sender is not notified.
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To suppress notification of external senders, set up two docu-

ments: one for internal senders with notifications enabled and the 

other for external senders with notifications disabled altogether 

(Basics tab, Notify sender option set to → Never notify).

In case of absence, you can also use the * and # options to send a 

notification to the sender without forwarding the mails:

1. In the Basics tab, enter a hash (#) in the Forwarding recipi-

ent field.

2. In the Sender notification mode field, enable the Always 

notify option.

3. In the Operations tab, enter the text for the sender in the 

Message for sender in case of none forward field and set 

the Replace original body option to No.

4. In the Advanced tab, define the exceptions for notification 

without forwarding, i.e. the senders that are not to be noti-

fied, e.g. mailing lists:

a. Under Sender condition in the Person field, enter 

the e-mail address(es) not to be notified. Enter each 

address in a separate line.

b. Under Forward to in the Person field, enter an aster-

isk (*) in the corresponding address line.

c. Proceed similarly in the Group and Domain fields to 

exclude a group from the Addressbook or an entire 

domain.
E 16  LOTUS NOTES - ORGANIZIQ FOR IQ.SUITE 7



ORGANIZIQ.CLERK - ABSENCE MANAGEMENT
4. Under Document authors in the Misc. tab, you can specify an authorized 

person for this document, i.e. authorized to edit the forwarding settings. As 

in the Basics tab, you may select a person from the Notes address book.

5. Select the Comments tab and enter a short description of your document 

to provide a quick overview on its contents.

6. Save your settings with Save.

4.2.2 Standard Forward
Standard forwarding options are basically set in the same way as advanced for-

warding options. The difference is that standard forwarding options do not allow 

for exceptions (set in the Advanced tab). In addition, no other names may be 

entered in the Forwarding for field. For all other options, refer to the detailed 

description under “Advanced Forward” on page 12.

To create a standard forward document select New Entry --> Standard Forward. 

As for Advanced Forward, set the dates and select a deputy from the address 

book. Then set the document to Active.

Save your settings with Save.

In a standard-forward document, the address book field is not avail-

able. However, you can nonetheless specify multiple document 

authors. To do so, enter the addresses manually in the Document 

authors field, separated by comma.
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5 organiziQ.Clerk - Redirection

5.1 Overview
The redirection function can be described as an "electronic clerk" since the avail-

able settings go far beyond simple redirection.

Redirection is not restricted to a specified period of time. It is used to always redi-

rect the e-mails to the specified deputies D. A typical example: You do not wish to 

receive e-mails unless they come from your secretary. You would then have to 

make the following settings in your document:

redirect each mail to secretary (except those from secretary)

if e-mail is from secretary, then send

As the mails are redirected, the original recipient does not receive a copy. Also, 

no notification is sent to the recipient or the deputy, as this will normally not be 

necessary with redirected e-mails. Example:

You have included your address in a mailing list and wish to store the e-mails you 

receive via this list in a public folder and thus forward them immediately to the 

mailing database. You therefore redirect all the mails coming from this mailing list 

to the public folder and, of course, do not wish to see any of these e-mails in your 

own mailbox. Also, do not wish to automatically notify the sender (i.e. the mailing 

list) that you have redirected these e-mails.

5.2 Setting Up the Electronic Clerk
Only members of the experienced organiziQ.Clerk users group are allowed to set 

Redirection options (also refer to the authorization section on page 9).

The organiziQ.Clerk database version originally supplied contains two sample 

entries for Personal Settings. As almost all employees will have access to the 

Clerk database, these examples may well have been changed and therefore no 

longer be available.

In this case, please select New Entry --> Redirect and create a new document, 

using the example described below as reference. Once you have created the 
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document, you can update your own entry any time by selecting it from the list 

(double-click).

Further information on individual fields and their options is provided in the Online 

Help, available under the Help menu.

1. Select: Personal Settings --> By Person

From the list displayed next, select (double-click) Jack Goose and change 

the document (--> Edit). 

2. In the Basics tab, set the Personal Settings Status to Active.

In the Redirection for field, enter the name of the user whose mail is to be 

redirected. You may select a name from the Notes address book. If you 

enter an asterisk (*) in the Redirect to field, e-mails will not be systemati-

cally redirected. In this case, redirection is limited to the exceptions speci-

fied under Conditioned redirection in the Advanced tab. This allows to 

redirect e-mails coming from specific persons, groups or domains to spe-

cific persons or groups. The number sign (#) may not be used in this field.

In the case of a systematic redirection, neither senders nor recipients will 

be sent notifications. You may select names from the Notes address book. 

Simply Add or Remove names from the selection displayed when you 

click on the arrow:

Click on the arrow 
to select a name
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3. Now select the Operations tab.

This tab is used to define the only notification text available for redirected 

mail. This message is sent to the deputy of the user to tell him or her that 

the e-mail has been redirected and that you require a message from the 

deputy if the matter is urgent. Modify the settings according to your require-

ments, change the message wording or simply use the default settings.

Select Address 
Book Add name

Select name
Remove name
 LOTUS NOTES - ORGANIZIQ FOR IQ.SUITE 7  PAGE 21



ORGANIZIQ.CLERK - REDIRECTION

 PAG
4. In the Advanced tab, enter the exceptions you wish to make.

Use the Person, Group, and Domain fields to define exceptions to the 

rule and redirect any e-mails from these senders to other persons. 

In this example, the following exceptions have been defined:

a) E-mails coming from Donald Bull are not redirected but sent to you per-

sonally (* entered).

b) E-mails from the farmers group are redirected to Dolly Hunter and not 

to the general redirection address specified in the Basics tab.

c) E-mails from the butchers group are redirected to Mickey Sheep and 

not to the general redirection address specified in the Basics tab.

5. As for forwarding options, the Document authors field in the Misc. tab is 

used to specify an authorized person for this document, i.e. authorized to 

edit the redirection settings1. As in the Basics tab, you may select a per-

Use the * character to suppress the redirection of e-mails coming 

from specified persons, groups or domains. E-mails from senders 

marked with an asterisk will be sent to you regardless of the general 

redirection settings. You can thus make sure that you always person-

ally receive the e-mails from selected persons.

The number sign (#) cannot be used in this field.

1. For information on authorization, please contact your administrator.
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son from the Notes address book. Please do not change any settings in the 

Server field.

6. Select the Comments tab and enter a short description of your document 

to provide a quick overview on its contents.

7. Save your settings with Save.
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6 organiziQ.Smart

6.1 Basics
Do you want to hold back specific messages addressed to multiple recipients and 

send them at a later time? 

organiziQ.Smart is the module for deferred (delayed) sending.

The messages to be deferred are temporarily buffered and then sent to the mail 

server at the date and time specified.

Represented graphically, organiziQ.Smart works as follows:

This chapter explains in detail how to use the organiziQ.Smart functions. 

6.2 Deferred Sending of E-mails
You can send e-mails on particular days and/or times of day. A user might, for ex-

ample, want to send an e-mail on a particular day (offers, birthday wishes, etc.), 

but knows he will be out of office on that day. He can nonetheless send the mes-

sage immediately, with a note in the header that it is to be sent by the mail server 

on day X at time Y. This note is set by way of a keyword named <DELAY %PAT-

TERN%>, where the %Pattern% metasymbol is replaced with the number of 

minutes the mail is to be deferred or with the time and date on which the message 

is to be sent. Depending on the server setting selected by the administrator, one 

of two options will be available: 
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1. Delayed by interval

If the administrator has enabled the Interval delay option, the document is 

sent after of the specified number of hours and minutes. The delay interval 

has to be entered with leading zeros, e.g.: 5 min delay  <DELAY 00:05>

hh:mm hh = hours, mm = minutes.

2. Sending at a specified time

If the administrator has enabled the Send at fixed time option, the docu-

ment is sent at the time set by the user. If the time specified lies in the past, 

the message is automatically sent on the following day at the time set. The 

time has to be entered with leading zeros, e.g.: send at 0:05   <DELAY 

00:05>.

Possible formats:

tt.mm.jjjj|hh:mm tt = day, mm = month, jjjj=year

tt.mm.jj|hh:mm tt = day, mm = month, jj=year

mm-tt-jjjj|hh:mm mm = month, tt = day, jjjj=year

mm-tt-jj|hh:mm mm = month, tt = day, jj=year

hh:mm hh = hours, mm = minutes

When specifying a date, the time must also be entered. A date with-

out time is considered invalid! When entering date and time, please 

be sure to insert the vertical line (Pipe), without blanks.

It is basically possible to use both delay options - fixed time and by 

interval. 

Please check with your administrator which Smart settings are 

enabled and which options are available!
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7 organiziQ.Flash

7.1 Basics
organiziQ.Flash is the module for

instant notification, and

receiving mails without Notes client

organiziQ.Flash provides you with immediate notification when an e-mail arrives 

on the Domino server. A Notes client is not required and you can receive notifica-

tions for several e-mail addresses simultaneously.

Flash consists of two components: The first component is the administration mod-

ule managed on the server by the Notes Administrator. The second one, the sep-

arate Flash client, is installed on the user workstation [MS Windows (all versions 

supported except for Terminal Server)] and instantly informs the user of any new 

message.

Represented graphically, organiziQ.Flash works as follows:

This chapter explains in detail how to use the Flash client. If you have any prob-

lems or questions related to Flash, please contact your administrator.

7.2 The Flash Client

7.2.1 Installing organiziQ.Flash
First copy the file mailflash.exe from the CD to the Notes program directory, e.g. 

C:\Lotus\Notes. Also copy any sound files you want to use and which are 

specified in the Flash job on the mail server to the Notes directory. Right-click on 
 LOTUS NOTES - ORGANIZIQ FOR IQ.SUITE 7  PAGE 27



ORGANIZIQ.FLASH

 PAG
the mailflash.exe file to create a link which you can then drag into the Startup 

folder (Start --> Programs --> Startup) so that the Flash client is automatically 

loaded when the PC is started.

Your Start menu should look like the following under Startup:

Another icon is displayed as of iQ.Suite 7:

If included in the Startup folder, Flash is automatically started when the PC is 

booted. Should this not be the case, make sure the link to the mailflash.exe file 

is set correctly. Of course, you may also call the program manually using the Start 

menu or the Windows Explorer.

7.2.2 First Steps
For all versions up to 5.2, please check the following entries under Options:
E 28  LOTUS NOTES - ORGANIZIQ FOR IQ.SUITE 7



ORGANIZIQ.FLASH
The Client TCP-Port-Number is preset and can usually remain unchanged. On 

each client, this number must match the number already used on the server. 

Under Number of Messages, specify the number of messages that can arrive at 

the same time.

Additional options as of Version 7:

MS-Agent

If you enable the Use Agent checkbox, a small wizard (the MS Agent) will pop up 

to provide assistance and - if set accordingly on the server - read out incoming 

messages. The Microsoft Agents are a standard feature as of Windows 2000 
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(and higher). If your operating system does not include the msagent.exe pro-

gram - usually located in the msagent directory under the system directory (e.g. 

WINNT) - it can be downloaded from the MS Agent website:

http://www.microsoft.com/products/msagent/downloads.htm

The Downloads section contains various files enabling a customized setup of dif-

ferent components.

The msagent.exe file must, in any case, be installed and available. You may also 

select further wizards and language libraries, for instance another wizard than the 

preset one. 

Four different characters can be downloaded from the Microsoft website:

Using the MS Agent language option under Windows XP requires the 

SAPI 4.0 Runtime Support, which can also be downloaded from the 

Microsoft Download website above.
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Once downloaded, simply run the files to install them. 

To use another character, copy the selected acs file (e.g. merlin.acs) to the 

chars directory under the msagent directory. Remove the previous character by 

moving it to another location (in case you want to re-use it later). 

For further information on MS Agent, refer to Microsoft under:

http://www.microsoft.com/products/msagent/default.htm

Don’t say "Hello" and "Bye": Enable this checkbox if you do not wish to be wel-

comed and dismissed by the Agent.

Hide automatically: If enabled, the Agent automatically disappears after having 

done whatever it was supposed to do.

The Tray Icon options allow to include a Flash icon in the Task Bar.

Minimize to Tray: Moves Flash to the Tray (right-hand corner, next to the clock), 

from where it can be restored by double-clicking on the icon.

Doubleclick on Tray-Icon launches Notes: With this checkbox enabled, dou-

ble-clicking on the icon in the Tray does not call the Flash client but directly starts 

the Notes client. 

The following menu is displayed when you right-click on the icon in the Tray:

The chars directory must not contain more than one acs file!

Which language the Agent speaks, and whether it speaks at all, is set 

by the administrator on the mail server!
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The Mute On/Off switch is used to enable/disable the Agent. If disabled, the icon 

color changes from green  to red . In this case, only the subject line of 

new messages is displayed, the message itself is not read out.

All mails arriving while the client is set to Mute are added to the list with a red mail 

symbol. The current Mute setting is saved and automatically re-used when Flash 

is restarted. 

7.2.3 Using organiziQ.Flash
In the start-up screen, the column on the left displays the date and time of each 

message, while the details and the message body are shown in the large frame.

To be able to start Notes from the Flash client, the mailflash.exe file 

must be stored in the Notes program directory. Otherwise an error 

message is returned!

The message body is only displayed if this option has been directly 

set on the server.
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Flash only displays current messages, i.e. the messages just coming in on the 

server. Mails received in your mailbox before the Flash client was started are not 

shown.

If you want your deputy (to be set on the server) to receive the notification nor-

mally sent to your PC, click on the I’m leaving! button. 

When you are back and ready to receive new messages, click on I’m back now!.

7.2.4 Closing organiziQ.Flash
Click on File --> Exit:

Once the Flash client is closed, the e-mails are removed from the dis-

play to keep messages up-to-date and avoid confusion caused by 

too many e-mails displayed. If you want to re-read an earlier e-mail, 

you have to open the Notes client.
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8 Glossary

ACL (Access Control List)

List of entries in a database which controls access rights.

API

Application Programming Interface. Software user interface with which program 

functions can be called and data exchanged.

archive

See compression.

ASP

Application Service Provider; Single-source provider of IT services at an agreed 

price.

back office

General term for business areas responsible for processing business information 

and correspondence (for example secretary's office and order processing).

bitmap

A bitmap is an uncompressed, pixel-based image format for graphics and photos. 

Fax servers use image formats to generate the faxed image. If an image file is 

split up into rows and columns, the result is a raster graphic. Each dot is saved as 

a bit sequence with its color information. The bitmap file format (*.BMP files) is 

not commonly used in the Internet because it cannot be compressed. Graphics 

saved in the GIF or JPEG format significantly reduce the data volume. 

business-to-business

Electronic interaction, communication and trade between businesses.

business-to-customer

Electronic interaction, communication and trade between business and customer.

client

General term for computers and application programs that access the services 

and resources of a server.
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client/server systems

The server is a program which provides a service and a client is a program which 

uses this service. These services can work together on a single computer or be 

distributed across a network consisting of at least one central computer (the 

server), which makes its data, programs and any other connected devices avail-

able to one or more other computers (the clients).

compression

Size reduction of files to reduce network load, reduce transmission times and/or 

save on storage space. Several files can also be compressed into a single 

archive. A number of compression types are available, including self-extracting 

ones. They include ZIP, TAR, ARJ, GZip, ARC and LZH. Different types are used 

on different computer systems. On UNIX systems, GZip and TAR tend to be 

used, while on Windows systems, ZIP and ARJ are the preferred choice (also see 

packer). Because viruses can easily hide in archives - especially nested ones -, 

content security tools must be able to perform recursive analyses, i.e. decom-

press the files repeatedly to scan them in their original state.

content security

The management and scanning of the content of digital correspondence. Content 

security products protect computer networks and users from dangerous content 

that is either deliberately or accidentally embedded in e-mails or Internet trans-

missions.

customizing

Adapting software solutions to customer-specific requirements.

DatabaseGrabber

Processes the documents in the database, mostly time-controlled, but also event-

controlled. Also see MailGrabber.

data integrity

The data is authentic, i.e. it has not been subjected to unauthorized changes, 

either manually or automatically.

decompressor

Program for decompressing files. Also see compression.
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DHCP

Dynamic Host Configuration Protocol - server administration of IP addresses. 

This protocol is used for exchanging configuration information for a TCP/IP net-

work between a server and its clients. For instance, DHCP is used for the 

dynamic allocation of IP addresses within a LAN.

DNS (Domain Name Service)

The DNS assigns the logic names of computers on the Internet to corresponding 

IP addresses.

domain

The domain is a part of an address, which conforms to the conventions of the 

DNS (Domain Name Service). In the address, the domain levels are each sepa-

rated with a period, for example www.group-technologies.de. German domains 

are, for example, often registered with DENIC eG (www.denic.de) under the top 

level domain "DE" and can be viewed by all Internet users. Domain names can 

contain letters and numbers. The only allowed special (non alpha-numeric) char-

acter is the hyphen; accented and other special characters, such as ä, é and ß 

must be replaced with, for example ae, e and ss. The name must consist of at 

least three characters and contain at least one letter of the alphabet. Otherwise it 

could be mistaken for an IP address.

dynamic link library

Short: DLL. DLLs are Windows files which contain objects that are loaded dynam-

ically. In other words, they are loaded into memory only when an application 

needs them. While this method is also used to save memory, its main purpose is 

to provide libraries of standard objects that can be accessed by many applica-

tions.

e-business

Electronic business. Business processes using electronic means of communica-

tion; includes all stages in the value-added chain that take place electronically - 

from simple word processing through e-mail to complex databases and global 

networking.

e-business enabling

Establishing the prerequisites for e-business.
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e-business organization

The rule-based organization of inbound, outbound and internal information in 

e-business.

e-business security

Rule-based information protection and maintenance of data integrity in e-busi-

ness.

electronic mailbox

e-mail inbox and outbox, which only one specific user on a mail server is autho-

rized to access.

e-mail

Electronic mail. Communication medium with which information (text, speech, 

images, graphics, etc.) can be transmitted electronically.

e-mail account

Registered electronic post-box.

EMH (Enterprise Message Handler)

Interface between the GROUP base technology and individual modules.

encryption

Making a message illegible to prevent it from being read by unauthorized people. 

A range of different encryption methods can be used. Also see PGP and S/MIME.

fingerprint

Unique feature of a file, by which it can be identified. It is composed of the file's 

content or, if this is not possible, by a filename pattern, such as the file extension. 

Fingerprints are used to determine whether files should be forbidden or allowed. 

They can be generated by the user to allow Watchdog to identify the file type of 

an attachment.

Freeware

Free-of-charge software, typically to be downloaded from the Internet or available 

on sample CDs.
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Front-end/back-end configuration

Separate groups of servers for handling protocols (POP3, etc.) and data stores. 

The clients access front-end protocol servers, which connect, one after the other, 

with back-end database servers to query the required data.

GIF

Graphics Interchange Format. Standard graphics format developed by Com-

puServe for the Internet. The GIF format compresses image data with color depth 

of 256 colors (8 bits per pixel). Compressing files reduces the amount of data 

sent across a network and results in shorter transmission times. Unlike with the 

JPEG format, color transitions are sharp. Interlaced GIF files - a variant of the GIF 

format - allow a low-resolution preview while the image is loaded. For image files 

from the GIF89a format (another GIF variant), one color can be defined as alpha 

channel, which appears transparent. This feature is used to place images on col-

ored backgrounds on web pages. Also see compression.

Global Settings

General settings applying to the entire iQ.Suite.

groupware

Software that provides information and communication support for workgroups. It 

consists of integrated solutions for e-mail, a group calendar and scheduler, infor-

mation exchange, electronic conferencing and document and work management 

functions.

hotline

Central customer phone-in service unit.

hyperlink

Hyperlinks, also called URLs (Uniform Resource Locators), are links to a docu-

ment in another location or another location in the current document, for example 

to Internet web pages. They can be clicked with the mouse.

IAB

Internet Activities Board - coordination board for Internet research activities; con-

sisting of IETF and IRTF.
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IETF

Internet Engineering Task Force: standardization body for Internet standards, 

responsible for developing the TCP/IP protocols.

implementation

Putting a design or concept into practice by means of an executable program.

information stores for public folders

Part of the Information Store used to manage information in public folders. An 

information store for public folders consists of a Rich Text file (.EDB file) and a 

system-specific streaming Internet content file (.STM file), also see MIME.

infrastructure

In the context of groupware,all hardware and software components, communica-

tion equipment and organizational measures required for operating a groupware.

Integrated Collaborative Environment Software

See groupware.

Internet

Internet is the overall term for a worldwide information network (World Wide Web 

= www) and the associated technology, based on special standards, which give 

the Internet its independence from hardware and operating systems.

Intranet

Corporate data and communication network for information exchange, based on 

Internet technology ("private Internet"). Used, for example, for shared databases, 

info pools and phone directories.

IP address

Unique Internet Protocol address: the protocol used for the network layer of the 

Internet, used by computers to address each other. The address is represented 

by sequence of numbers, for example 129.13.64.5.

IRTF

Internet Research Task Force. Part of the IAB; supervises long-term development 

work of Internet technology.
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ISP

Internet Service Provider. Provides end clients with Internet access and related 

services. ISPs manage the Internet access points (points of presence).

ISP/ASP

See ASP and ISP.

IT

Information Technology. Covers all technologies used for creating, storing, 

exchanging and using all types of electronic information.

job

A job defines a sequence of actions which are performed when a particular event 

takes place or according to particular selection rules.A job can be active or inac-

tive. Several Jobs can be created for each GROUP module, which are then pro-

cessed according to their assigned priority for all modules. There are two job 

types: mail jobs, which process inbound and outbound e-mails, and database 

jobs, which run on the selected databases. Mail and database jobs run indepen-

dently of each other and are never, therefore, listed in the same view.

JPEG

Also JPG. Abbreviation for Joint Photographic (Experts) Group format, pro-

nounced "jaypeg". JPEG is the standard Internet format for photo realistic 

images. The JPEG format compresses image data to a color depth of 16 777216 

colors (24 bits per pixel). Compressing files reduces the amount of data sent 

across a network and results in shorter transmission times. Unlike the GIF format, 

the JPEG format is especially well suited for photorealistic images with many col-

ors. Higher compression ratios result in a reduced image quality, but in practice 

this loss is often barely noticeable. Scanned photos and images from digital cam-

eras are often saved in JPEG format, and many fax servers also use this format. 

Also see compression.

junk mail

All forms of unwanted e-mail that were not requested by the recipient, such as 

invitations to view websites, images, chain letters, hoax virus warnings, and 

advertising of the "make money faster" variety. Junk mails cost the company 

resources and the recipient time. Also see spam (often used in a similar sense).
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Knowledge Management System

System by which a company collects, organizes, sorts and analyses knowledge 

to support its aims.

LDAP

Lightweight Directory Access Protocol. The LDAP Internet protocol was devel-

oped to encourage the adoption of the X.500 directory standard, as the original 

DAP (Directory Access Protocol) had been to complex to use for simple Internet 

clients. LDAP defines a relatively simple protocol for updating and searching 

directories running over TCP and thus enables manufacturer-independent access 

to directory services. Such a directory service could for instance include an insti-

tution's names, e-mail addresses, phone numbers, etc. E-mail clients with LDAP 

support have direct access to the addresses on the server. The number of 

addresses output is limited to 50 at a time.

LDIF

LDAP Data Interchange Format. LDIF is mainly used for exchanging address 

data on LDAP servers. LDIF is a text-based format (ASCII) that can be easily 

edited using standard editors. LDIF is supported by many e-mail clients for 

importing/exporting address books (e.g. Outlook, Outlook Express, Netscape, 

The Bat!).

macro virus

Infect documents of the widely-used MS Office applications (Word, Excel, Access 

and PowerPoint). MS Office applications can be controlled using the VBA pro-

gramming language, which is embedded in Office documents in the form of mac-

ros. HTML documents created with Word can also contain macro viruses. Macro 

viruses can even spread across different operating systems, since MS Office - 

not the operating system - interprets and executes the macro.

mail flooding

Mail flooding is the sending of a large number of e-mail messages, usually from a 

single domain, to a mail server at intervals of a few seconds. These "attacks" 

result in the mail server becoming overloaded as it has to deal with the mail mes-

sages, which severely affects its performance. These messages are usually 

unwanted mail sent with malicious intent (also see spam).
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MailGrabber

Module for processing e-mails. The MailGrabber processes e-mails sent by the 

Domino server on which the MailGrabber is installed. For each e-mail, it calls the 

correspondingly configured function modules, for example Watchdog.

messaging platforms

Hardware and software platforms for e-mail or electronic communication.

MIME

Multipurpose Internet Mail Extensions. Originally a method for encrypting non-

text objects to allow their transmission using SMTP and e-mail. This method is 

used today universally with Internet transmissions and provides further possibili-

ties of transmitting e-mail through the definition of special control codes for spe-

cial characters such as accents and attachments of any file type. Also see 

S/MIME.

module

A program unit with definable boundaries and action, which is embedded in an 

overall system as an independent, autonomous program component e.g. securiQ 

with the modules Watchdog and Wall.

mount

To connect to the file system (drive) of another computer system.

OEM

Original Equipment Manufacturer. Company that buys other manufacturers' prod-

ucts or components and incorporates these in other products that it sells under its 

own name.

packer

Compression program; see compression. 

PGP

Pretty Good Privacy. A program for encrypting e-mails. Can also be used to elec-

tronically sign documents. Guarantees the recipient of such a document that the 

sender is the real author and the document was not sent or modified by another 

user. PGP is Freeware and therefore freely available from many shareware 
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archives. In the context of e-mail, PGP is a standard like S/MIME. PGP is plat-

form-independent. Also see encryption.

platform

System (software), for example Lotus Notes or Microsoft Exchange (as well as 

operating systems), on which other applications or processes - such as iQ.Suite - 

can be run.

POP3

Abbreviation for Post Office Protocol 3 (the number 3 stands for the protocol ver-

sion). POP3 is a transfer protocol used for controlling receipt of e-mail from a 

remote mail server, on which messages are stored until they are retrieved by their 

recipient. POP3 uses a TCP/IP connection. The protocol has been developed 

specifically for receiving e-mail, and, unlike SMTP, does not need a dedicated 

line.

Policy

A policy is a combination of rules and jobs, i.e. the configuration settings in the 

iQ.Suite.

Quarantine

Exchange: An archive folder in which virus-infected and/or forbidden files are 

stored and where they can be accessed by authorized persons.

Domino: An archive database in which virus-infected and/or forbidden files are 

stored and where they can be accessed by authorized persons.

RemoteGrabber

A MailGrabber which is installed on a Notes client PC, not, unlike the MailGrab-

ber, on the Domino server. The RemoteGrabber is used to scan e-mails across 

the network on a remote Domino server (e.g. for viruses). Only e-mails with the 

corresponding status (see RemoteRequester) are processed.

RemoteRequester

A function module for the MailGrabber, which makes the e-mails to be processed 

available to the RemoteGrabber. It assigns a special status to the e-mails that are 

to be processed by the RemoteGrabber, which retrieves the mails from the client 

and processes them there.
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replication

Synchronization of data between two identical databases on two different servers.

reseller

Dealership which, in addition to the software itself, offers its own services to cus-

tomers.

RFC 821

Abbreviation for Request for Comments. RFC 821 defines the SMTP protocol and 

is today the basis for transporting e-mails on the Internet. This standard was 

developed in 1982 as RFC 821 and RFC 822. RFC 822 defines the format of e-

mail messages. A series of RFC documents created by the IAB are available.

Rich Text Format (RTF)

A generic file format used for transferring formatted text between applications, 

even between different operating systems.

RSA

Commonly used encryption method named after its inventors – Rives, Shamir 

and Adleman. RSA is also used with PGP. In RSA encryption, two large prime 

numbers are linked to form an even larger single prime number, which is then 

used for encryption. From a certain bit width (about 100 bit), not even the fastest 

supercomputers can crack this encryption. The required processing capacity is 

doubled with every additional bit. 

rule

See selection rules.

rule-based

The execution of electronic processes or functions on the basis of particular rules 

defined by the system administrator.

scalability

The adaptability of an IT system to user requirements regarding processing 

speed storage capacities and the number and type of connected workstations.

selection rules

Selection rules restrict the number of e-mails or databases that are checked by 

iQ.Suite. The rules filter the mails and databases according to user-defined 
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Policy, which allows operators to optimally adapt the software to their corporate 

security concept, see rule.

server

Central system (hardware or applications; in general a universally accessible 

computer) which provides a particular service that can be used by the worksta-

tions (clients) connected to the network à client/server systems.

server-based

Programs are installed on a server and are also executed there.

shareware

Software provided by its developer for a trial period. If the user decides to con-

tinue using the software, a registration fee must be paid to the author. The trial 

version of a shareware program may be restricted in its functionality. On payment 

of the registration fee the user receives the full, unrestricted version.

S/MIME

Secure Multi-purpose Internet Mail Extensions. A secure version of MIME. 

S/MIME is the industry standard for the encryption of e-mails sent between the 

same and different types of e-mail systems. S/MIME can use a range of signature 

and encryption algorithms. Also see PGP.

SMTP

Abbreviation for Simple Mail Transfer Protocol. Transmission protocol to RFC 821 

for receiving and sending e-mail. SMTP belongs to the TCP/IP family of proto-

cols. SMTP messages consist of a head containing at least a sender and recipi-

ent ID, and the actual message. The message is forwarded from the sender by an 

e-mail program - the user agent (UA) - to the network's own mail server - the 

Message Transfer Agent (MTA) - which, in turn, forwards the message to other 

MTAs along the transmission path according to the "Store and Forward" principle, 

until the message reaches its recipient. SMTP works with 7-bit ASCII, which 

means that accented and extended characters cannot be represented and unau-

thorized access cannot be prevented. ESMTP, in contrast, uses 8 bits for mes-

sage transmission. Unlike the Post Office Protocol (POP3), SMTP needs a 

dedicated line for receiving mail.
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spam

Unwanted e-mails, which are generally sent to a large distribution list. Spam 

includes advertising mail. Also see junk mail.

SSL

Secure Socket Layer – developed by Netscape, provides secure data transmis-

sion through a network. With SSL, data can be encrypted for transmission (RSA 

encryption) to protect it from thirt-party access. Used, for example, for sending 

credit card information.

Stored Forms

Templates and graphic elements within Lotus Notes.

suite

A set of applications from a manufacturer which are sold as a package, for exam-

ple, e-business security.

supported applications

Commercially available programs and tools (e.g. WinZip, Sophos Virus Scanner, 

PGP, etc.).

system architecture

Structure of an IT system, consisting of hardware and software components.

system integrator

Provider who integrates hardware and software products from different manufac-

turers and its own components into overall solutions.

TCP

Abbreviation for Transmission Control Protocol. Next to IP, this is the main proto-

col used on the Internet. It provides applications with a connection-oriented, reli-

able duplex service in the form of a data stream.

TCP/IP

Combination of TCP and IP (abbreviation for Transmission Control Protocol/Inter-

net Protocol); originally developed for UNIX networks, it is today used as the main 

network protocol of the Internet. It splits data into convenient packages and sends 

them across the network, using IP addresses (Internet Protocol addresses) to 
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find their destination. There, TCP reassembles the data packets again. In addi-

tion, several Internet applications can be run using a single modem or ISDN line.

tools

Small programs and accessory software.

trusting domain

A domain that trusts another. This domain assigns rights to the trusted domain 

and allows users from this trusted domain to access its resources.

trusted domain

A domain that is trusted. Users in trusted domains can, for example, access the 

resources or receive user rights in a trusting domain.

Universal Naming Convention (UNC)

A naming convention for files and other resources. The two backslashes (\) at the 

beginning of a name indicate that the corresponding resource is located on a net-

work station. UNC names have the syntax \\server name\shared resource.

VBA

Visual Basic for Applications. With this programming language from Microsoft, 

MS Office programs, such as Word, Access and Excel can be controlled.

virus scanner

Program for finding viruses.

virus

A virus is program code that can be transmitted from one file or object to another. 

Viruses are defined by their ability to reproduce themselves. Viruses can infect 

other programs by copying themselves into another file or the boot sector of a 

disk drive.

web

Synonymous with Internet, whereby the focus is on its worldwide presence.

web connect

Connection to the Internet.
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wildcard

A character which represents another character or a character string. The best 

known wildcards are the question mark and the asterisk, which are used by the 

DOS command interpreter. The question mark (?) represents an individual letter 

or number, the asterisk (*) represents a string.

worm

A self-executing program which can replicate itself. Unlike a virus, a worm does 

not need a container file (.com, .exe or Visual Basic within a document) to spread; 

macro viruses are often worms.

XML (Extensible Mark-up Language)

Meta-language for defining mark-up languages (such as HTML).

ZIP of Death

"ZIP of Death" refers to recursively packed ZIP files originating from an rather 

small 42 KB e-mail that, as such, is neither dangerous nor virus-infected. How-

ever, it contains over 1 million packed files that, once unpacked, add up to 

49,000,000 Gigabytes. When processed by a virus scanner decompression tool, 

this unconspicuous e-mail initiates virtually endless loops ususally resulting in a 

system crash. This not only affects the virus scanners of client computers but also 

the mail servers which usually crash and paralyze the entire e-mail traffic within a 

few minutes.
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